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About This Guide

This document describes the installation and initial configuration of the Extreme Networks Management
Center NMS-A-25 hardware engine.

This document is intended for experienced network administrators who are responsible for
implementing and maintaining communications networks.

Text Conventions

The following tables list text conventions that are used throughout this guide.

Table 1: Notice Icons

-
D

(

Icon Notice Type Alerts you to...
o General Notice  Helpful tips and notices for using the product.
‘ Note Important features or instructions.
|
| Rl
2 Caution Risk of personal injury, system damage, or loss of data.
2 Warning Risk of severe personal injury.
o New This command or section is new for this release.

Table 2: Text Conventions

Convention

Description

Screen di spl ays

This typeface indicates command syntax, or represents information as it appears on the
screen.

The words enter and
type

When you see the word “enter” in this guide, you must type something, and then press
the Return or Enter key. Do not press the Return or Enter key when an instruction
simply says “type.”

[Key] names

Key names are written with brackets, such as [Return] or [Esc]. If you must press two
or more keys simultaneously, the key names are linked with a plus sign (+). Example:
Press [CtrI]+[Alt]+[Del]

Words in italicized type

ltalics emphasize a point or denote new terms at the place where they are defined in
the text. Italics are also used when referring to publication titles.
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About This Guide

Related Publications

Extreme Management Center™ Documentation

Extreme Management Center (EMC, formerly NetSight) documentation, including release notes, are
available at: http://documentation.extremenetworks.com.

Extreme Management Center online help is available by clicking the ? icon in all EMC pages. The online
help provides detailed explanations of how to configure and manage your network using EMC.

For complete regulatory compliance and safety information, refer to the document /Inte/” Server
Products Product Safety and Regulatory Compliance.

Getting Help

If you require assistance, contact Extreme Networks using one of the following methods:

GTAC (Global Technical Assistance Center) for Immediate Support

* Phone: 1-800-998-2408 (toll-free in U.S. and Canada) or +1 408-579-2826. For the support
phone number in your country, visit: www.extremenetworks.com/support/contact

o Email: support@extremenetworks.com. To expedite your message, enter the product name or
model number in the subject line.

GTAC Knowledge — Get on-demand and tested resolutions from the GTAC Knowledgebase, or

create a help case if you need more guidance.

The Hub — A forum for Extreme customers to connect with one another, get questions answered,

share ideas and feedback, and get problems solved. This community is monitored by Extreme

Networks employees, but is not intended to replace specific guidance from GTAC.

Support Portal — Manage cases, downloads, service contracts, product licensing, and training and

certifications.

Before contacting Extreme Networks for technical support, have the following information ready:

Your Extreme Networks service contract number and/or serial numbers for all involved Extreme
Networks products

A description of the failure
A description of any action(s) already taken to resolve the problem

A description of your network environment (such as layout, cable type, other relevant environmental
information)

Network load at the time of trouble (if known)

The device history (for example, if you have returned the device before, or if this is a recurring
problem)

Any related RMA (Return Material Authorization) numbers

Providing Feedback to Us

We are always striving to improve our documentation and help you work better, so we want to hear
from you! We welcome all feedback but especially want to know about:

Content errors or confusing or conflicting information.

Extreme Management Center® NMS-A-25 Installation Guide / 5


http://documentation.extremenetworks.com
http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf
http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf
http://www.extremenetworks.com/support/contact
http://www.extremenetworks.com/support/contact/
mailto:support@extremenetworks.com
https://gtacknowledge.extremenetworks.com/
https://community.extremenetworks.com/
http://support.extremenetworks.com/

About This Guide

e |deas for improvements to our documentation so you can find the information you need faster.
e Broken links or usability issues.

If you would like to provide feedback to the Extreme Networks Information Development team about
this document, please contact us using our short online feedback form. You can also email us directly at
internalinfodev@extremenetworks.com.
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1 Engine Overview and Setup

Kit Contents
Specifications
Front Panel Features

Back Panel Features
Removing and Installing the Front Bezel
Installing the Engine into a Rack

This chapter lists the components shipped with the NMS-A-25 engine, describes the front and back
panels, and provides information on engine specifications.

For complete regulatory compliance and safety information, refer to the document /nte/” Server
Products Product Safety and Regulatory Compliance, available at the following links:

http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf
http://www.extremenetworks.com/support/documentation/

Kit Contents

The NMS-A-25 engine ships with the following components:

e Extreme Networks URL card

e Front bezel label

e Arack mounting kit

e Two rack handles and appropriate screws

e AC power cord bracket and cable clamp kit
e One USB flash drive

Specifications

The physical specifications for the engine are listed in Table 3. The environmental requirements are
listed in Table 4 on page 8.

Table 3: NMS-A-25 Physical Specifications

Processor

Processor type NMS-A-25 - Intel® Xeon® E5-2620 v4 processor
Processor speed 21GHz

CPU Cores 8

Memory

Architecture 2400MHz Dual Ranked Registered (RDIMM) ECC DDR4
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Table 3: NMS-A-25 Physical Specifications

(continued)

Memory module capacities

4 GB DIMMs

Minimum RAM (included)

32 GB (eight 4 GB DIMMs)

Maximum RAM 48 GB (twenty-four 2 GB RDIMMs)
Drives

Hard drives One 480 GB SSD hard drive
Connectors

Back

NIC Four RJ-45

Serial 9-pin, DTE, 16550-compatible
USB Three 4-pin, USB 2.0-compliant
Video 15-pin VGA

Networking Two 1 GB Ethernet

Front

USB Two 4-pin, USB 2.0-compliant
Video 15-pin VGA

Power

AC power supply (per power supply)

Redundant power supply

Wattage

750 watts

Input voltage

e 90-132Vat47/63Hz82A
* 180-264Vatd7/63Hz4.4 A

Output voltage e 620Aat12V

e 21Aat12VSB
Physical
Height 4.45cm (1.72in.)
Width 43.0.cm (16.93in.)
Depth 70.99 cm (27.951n.)

Weight (maximum configuration)

1315 kg (29 1b.)

Table 4: NMS-A-25 Environmental Specifications

Parameter

Limits

Operating temperature

+10°C (+50°F) to +35°C (+95°F) with the maximum rate of change
not to exceed 10°C (+50°F) per hour

Storage temperature

-40°C (-40°F) to +70°C (+158°F)

Storage humidity

50% to 90%, non-condensing at 28°C (82°F)

Vibration, unpackaged

5Hz to 500 Hz, 2.20 g RMS random
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Table 4: NMS-A-25 Environmental Specifications (continued)

Parameter Limits

Shock, operating Half sine, 2 g-force peak, 11 milliseconds

Shock, unpackaged Trapezoidal, 25 g, velocity change 136 inches/second (40 Ib to < 80
1b)

Shock, packaged Non-palletized free fall in height 24 inches (40 Ib to < 80 Ib)

ESD +12 KV except 1/0 port £8 KV per Intel® Environmental test
specification

Estimated thermal dissipation 1550 BTU/Hr

Front Panel Features

The following figure shows the NMS-A-25 engine front panel features. Figure 2 on page 9 shows the
front control panel.

Figure 1: NMS-A-25 Front Panel Features

A | System label pull-out D | Front control panel (see Figure 2 on page 9)

B | Video Connector E | Hard disk drive bays

C |USB 3.0 Ports

A BCDE F G

Figure 2: Front Control Panel

A System ID button w/integrated LED F  System status LED
B NMI button (recessed, tool required for use) G Power button w/integrated LED
C  Mgmt port activity LED H Hard drive activity LED
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D Notused | Not used

E  System cold reset button J  Not used

Hard Drive LED Indicator Patterns

The hard drive has two LED indicators visible from the front of the system: one is a green LED for disk
activity, and the other is amber and indicates hard drive status. The LEDs have the following states, as
described in Table 5.

Table 5: Hard Drive Activity LED Indicator Patterns

Activity LED Patterns Hard Drive Condition
Off Power on and drive spinning up or spinning down
Blinking green Power on with drive activity

Table 6: Hard Drive Status LED Indicator Patterns

Status LED Patterns Hard Drive Condition
Off No access or no fault
Solid amber Hard drive fault has occurred

Back Panel Features

Figure 3 shows the NMS-A-25 engine back panel.

Figure 3: NMS-A-25 Back Panel

A Power supply module #1 F Serial port

B Power supply module #2 G USB 2.0 ports

C ethO H Mgmt port, out of band
D ethl | I/0 Module Bay

E Video connector J Riser cards, not used

Table 7 describes the LEDs for the RJ45 management port.
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Table 7: RJ45 Port LEDs (Management Port)

LED Type LED Pattern Status Indication
Network speed (right) Off 10 Mbps

Amber 100 Mbps

Green 1000 Mbps
Link activity (left) Off No link

Solid Green Active link

Blinking Green

Data traffic activity

Power Supply Status Indicator Patterns

The engine has two power supplies, supplying hot-pluggable power redundancy. The system distributes

the power load across both power supplies to maximize efficiency.

Each power supply has a single bi-color LED to indicate power supply status, as described in the table

below.

Table 8: Power Supply Status LED Indicator Patterns

LED Pattern

Power Supply Condition

Green

Output on and OK

Off

No AC power to all power supplies

1Hz blinking green

AC present / Only 12VSB on (PS off) or PS in cold redundant state

Amber

AC power cord unplugged or AC power lost. With a 2nd PS in parallel still with AC input

power

1 Hz blinking amber

Power supply warning events where PS continues to operate — high temp, high power,

high current, slow fan

Amber

Power supply critical event causing a shutdown, failure, OCP, OVP, fan fail

2 Hz blinking green

Power supply firmware updating

Removing and Installing the Front Bezel

The NMS-A-25 engine comes with an optional front panel bezel that can be attached to the front of the
chassis by snapping the bezel onto the chassis handles. A key lock allows you to lock the bezel in place
so that front panel controls cannot be used. You can still monitor system status indicators with the bezel

in place.

Removing the Front Bezel

To remove the front bezel:

1 Unlock the bezel if it is locked.
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2 Remove the left end of the front bezel from rack handle.
3 Rotate the front bezel counterclockwise to release the latches on the right end from the rack handle.

Installing the Front Bezel

Note
0 Before installing the bezel, you must install the rack handles. See Installing the Engine into a
Rack on page 12.

To install the front bezel:

1 Lock the right end of the front bezel to the rack handle.
2 Rotate the front bezel clockwise till the left end clicks into place.
3 Lock the bezel, if needed.

Installing the Engine into a Rack

A rack mounting kit and installation guide are included with the NMS-A-25 engine. The rack mounting
kit allows you to install the engine into a four-post rack cabinet. Refer to the installation guide for
complete installation instructions.

If you are table mounting the engine, ensure at least 6 cm (2.4 in) of clearance on all sides of the engine
for proper ventilation.

If you are installing the engine in a rack:

1 Install the rack handles by aligning a rack handle with the two holes on each side of the engine and
attaching each handle to the engine with two screws as shown in the figure below.

Figure 4: Installing the Rack Handles

2 Read the installation guide included with the rack mounting kit.
3 Install the rails and mount the controller in the rack as instructed.

Torque Values

Table 9 describes the recommended torgue values to use when installing the engine using standard
threaded fastener machine screws and bolts.
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Table 9: Recommended Torque Values by Screw Size

Screw Size Torque in Pounds Bit Size
English Metric -%5 Nominal +%5

N/A N/A 142 15 157 0
2-56 15 2.85 3.0 315 0
4-40 25 475 5.0 525 0/1
6-32 35 8.55 9.0 9.45 1

8-32 45 17.10 18.0 18.90 2

10 - 32 5 30.40 32.0 3360 2
1/4-20 6.5 63.65 67.0 70.35 3
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2 Configuration

Pre-Configuration Tasks
Configuring the Engine
Launching Extreme Management Center Applications

Restoring a Database from a Windows Server to the Engine
Changing Engine Settings
Upgrading Extreme Management Center Engine Software

Once you have installed the engine into a rack, you need to connect a monitor and a USB keyboard,
connect the power cord and network cable, and power it on (see Figure 1 on page 9 and Figure 3 on
page 10).

After the engine boots and the engine installation is complete, you must go through the initial
configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your initial
configuration and how to upgrade the Extreme Management Center application software. For
information on reinstalling the Extreme Management Center engine software, see Reinstalling Engine
Software on page 22.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing the configuration steps in the next
section:

¢ Engine hostname, IP address, and netmask

e Default gateway IP address

e Name server |P address and domain name

* NIS (Network Information Services) server IP address

¢ Network Time Protocol (NTP) server IP address

In addition, you need to obtain the appropriate Extreme Management Center software license prior to
launching the Extreme Management Center applications. You are prompted to enter a license when you
launch the application. (When you purchased Extreme Management Center, you received a Licensed
Product Entitlement ID. This Entitlement ID allows you to generate a product license. Refer to the
instructions included with the Entitlement ID that was sent to you.)

Configuring the Engine

After the initial engine installation is complete, use the following steps to configure the engine to run
the Extreme Management Center engine software:

1 Login as root with no password, and press [Enter].
The following screen appears:
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Extrene Networks - Extrene Managenent Center Suite Engine

Wl come to the Extrene Managenment Center Engi ne Setup

Pl ease enter the infornation as it is requested to continue with the configuration.
Typically a default value is displayed in brackets. Pressing the [enter] key w thout
entering a new value will use the bracketed value and proceed to the next item

If a default val ue cannot be provided, the pronpt will indicate that the itemis either
(Required) or (Optional). The [enter] key may be pressed without entering data for
(Optional) items. A value nust be entered for (Required) itemns.

At the end of the setup process, the existing settings will be displayed and
opportunity will be provided to correct any errors.

Press [enter] to begin setup or CTRL-C to exit:
2 Press [Enter] to begin the setup. The Root Password Configuration screen appears:

Root Password Confi guration

There is currently no password set in the system adm ni strator
account (root). It is recommended that you set one that is
active the first time the machine is rebooted.

Wuld you like to set a root password (y/n) [y]?

Note
@ You must set a new root password. This new root password is used by the initial user when
logging in to the Extreme Management Center applications.

3 Press [Enter] to set a new root password. Enter the new password as prompted.

Enter new UNI X password:
Ret ype new UNI X password:

Password updat ed successful ly.

4 After you create the new root password, a screen appears where you can specify a user other than
root to run the Extreme Management Center server, if desired. This user becomes the admin user for
the server.

Sel ect the user to run the server as

Do you want to use an existing user? (y/n) [y]

5 Entery to use an existing user if you already have a user defined on the machine and enter the user
name. Leave the name set to root if you do not want to specify another user. Accept your selection.
Enter n to create a new "netsight” user (netsight is the user name) and enter the password for this
new user. Re-enter the password and then accept your selection.
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6 Inthe Extreme Management Center Suite Engine Network Configuration screen, enter the requested
configuration information and press [Enter].

If you plan to use DNS, enter the IP address of the name server. If you are using a name server, enter
a domain name for the engine. If you are using an NIS server to authenticate users logging into the
engine, make sure the NIS domain name is valid or users may not be able to log in to the Extreme
Management Center applications.

Ext rene Managenent Center Suite Engi ne Network Configuration

Enter the hostnanme for the engine (Required):

Enter the | P address for <hostnane> [192.168. 1. 10]:
Enter the | P netmask [255.255.255.0]:

Enter the gateway address [192.168.1.1]:

Enter the | P address of the nane server (Optional):
Enter the donmi n nane for <hostnane> (Optional):

Do you want to use NIS (y/n) [n]? vy
Enter the | P address of the NI S server:
Enter the NI'S domai n name (Required):

7 In the Confirm Network Settings screen, you can accept the current configuration or modify the
settings.

Confirm Network Settings

These are the settings you have entered. Enter O or any key other than a valid
sel ection to continue.|f you need to make a change, enter the appropriate nunber now or
run the /usr/postinstall/dnetconfig script at a later tine.

0. Accept settings and continue

1. Host nane: <host nanme>

2. | P address: 192. 168. 1. 10

3. Net mask: 255. 255. 255. 0

4. CGateway: 192.168.1. 1
5. Naneserver:

6. Domai n nane: <domai n nanme>

7. NI'S Server/ Donai n:

Enter selection [0]:
8 In the SNMP Configuration screen, enter the requested information for each line and press [Enter].

SNMP Confi guration

The following information will be used to configure SNWP nmanagenent of this device. The
SNWP i nformati on entered here nust be used to contact this device with renote
managenent applications such as Extrene Managenent Center Consol e.

Pl ease enter the SNWMP user name [snmpuser]:
Pl ease enter the SNMP aut hentication credential [snnpauthcred]:
Pl ease enter the SNWP privacy credential [snnpprivcred]:

9 Inthe Configure Date and Time Settings screen, select whether you want to use an external Network
Time Protocol (NTP) server. Enter y to use NTP, and enter your NTP server IP address(es). Enter n to
configure the date and time manually and proceed to step 11.

Configure Date And Tinme Settings

The engine date and tine can be set manually or using an external
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Network Time Protocol (NTP) server. It is strongly reconrended that

NTP is used to configure the date and time to ensure accuracy of tinme

val ues for SNMP communi cations and | ogged events. Up to 5 server | P addresses nay be
entered if NTP is used.

Do you want to use NTP (y/n) [y]? vy

Pl ease enter a NTP Server |P Address (Required): 144.131.10.120
Wul d you like to add another server (y/n) [n]? y

Pl ease enter a NTP Server |P Address (Required): 144.131.10.121
Woul d you like to add another server (y/n) [n]? n

10 In the NTP Servers validate selection screen, enter 0 to accept the current settings and proceed to
the Set Time Zone screen in step

NTP Servers

These are the currently specified NTP servers. Enter 0 or any key other than a valid
selection to conplete NTP configuration and continue.

If you need to make a change, enter the appropriate nunber fromthe choices |isted
bel ow.

144.131.10. 120

144.131.10. 121

0. Accept the current settings

1. Restart NTP server selection

2. Set date and tine manual ly

Enter selection [0]: O
11 If you answered no to using an NTP server to set date and time, set the date and time in the Set Date
and Time screen.

Set Date And Tine

The current systemdate and tine is: Thu Oct 28 09: 34: 08 2013
Pl ease enter the values for date and tine as directed where input is expected in the
foll owing fornat:

MM - 2 digit nmonth of year

DD - 2 digit day of nonth

YYYY - 4 digit year

hh - 2 digit hour of day using a 24 hour clock
mm - 2 digit minute of hour

Ss - 2 digit seconds

Pl ease enter the nonth [10]:

Pl ease enter the day of the nonth [28]:
Pl ease enter the year [2013]:

Pl ease enter the hour of day [09]:

Pl ease enter the minutes [34]:

Pl ease enter the seconds [08]:

12 In the Use UTC screen, select whether you want the system clock to be set to use UTC.

Use UTC

The system cl ock can be set to use UTC. Specifying no for using UTC
sets the hardware cl ock using |localtine.

Do you want to use UTC (y/n) [n]?
13 In the Set Time Zone screen, select the appropriate time zone and press [Enter].

Set Time Zone

You will now be asked to enter the time zone information for this system Avail able
tine zones are stored in files in the /usr/share/zoneinfo directory. Please select from
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one of the follow ng exanple tinme zones:
US Eastern

US Central

US Mount ai n

US Pacific

O her - Shows a graphical Iist

(OISR ONS

Enter selection [1]:

14 The Modify Settings screen summarizes the settings you have entered and provides an opportunity
to modify the settings, if desired. Enter 0 to accept the settings.

Modi fy Settings

Al of the infornmation needed to conplete the installation of the Extrenme Managenent
Center Engine has been entered. Enter 0 or any key other than a valid selection to
continue. If you need to make a change, enter the appropriate nunber fromthe choices
l'isted bel ow

0. Accept settings and continue

1. Set the root user password

2. Set user to run server as

3. Set hostname and network settings
4. Set SNWP settings

5. Set the systemtine

6. Mdify all settings

Enter selection [0]:

The Extreme Management Center engine software is automatically installed. This could take a few
minutes. When the installation is complete, you'll see the following screen:

Extreme Networks - Extreme Managenent Center Suite Engine - Setup Conplete

Setup of the Extrene Managenent Center Engine is now conplete. The engine is now
operational and ready to accept renote connections. Details of the installation are
located in the /var/log/install directory.

Launching Extreme Management Center Applications

Now that you have configured the Extreme Management Center engine, you are ready to access the
Extreme Management Center Launch Page and run the applications from a remote client machine.
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1

Open a browser window on the remote client machine and enter the Extreme Management Center
Launch page URL in the following format:

http://<server nane>: 8080/

where <ser ver nane> is the Extreme Management Center engine IP address or hostname, and
8080 is the required port number. For example,

http://10.20. 30. 40: 8080/
The Extreme Management Center Launch Page opens.

Launch your Extreme Management Center applications by clicking on the names or icons of any of
the listed applications.

A login window appears.
Log in as root with the same password you defined in or as the user you specified in Step 3.

This is because the Extreme Management Center Server has a single predefined user that is the user
who performed the installation. Once the initial user has logged in, additional users can be defined.

The first time you attempt to launch an Extreme Management Center application, you are prompted for
the license text you received when you generated your Extreme Management Center product license.

For more information on the Extreme Management Center Launch page, access the Online Help by
clicking on ? in top-right corner. In the Online Help Table of Contents, select /nstallation Guide and then
read the section titled "Remote Client Launch.”

Restoring a Database from a Windows Server to the Engine

This section describes several Extreme Management Center configuration changes that are required if
you are moving your Extreme Management Center installation from a Windows platform system to the
engine. The steps are performed after restoring your database to the new engine. (For information on
restoring a database, see the Server Information section in the Extreme Management Center Suite-Wide
Tools User Guide.)

Changing Console

Use the following instructions to change the location of syslog and trap information to the new location
on the engine.

Changing Syslog Location

Change the Syslog Log Manager to point to the new location on the engine. This allows the display of
syslog information in the Syslog Event View tab.

1
2

From the Console menu bar, select Tools > Alarm/Event > Event View Manager.
Click on the Syslog entry under Available Log Managers, and click the Edit button.
The Log Manager Parameters window opens.

Change the path in the Log Directory field to/ var / | og/ nessages.

Change the Pattern to Red Hat LINUX Syslog Pattern.

Click OK.
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Changing Traps Location

Change the Traps Log Manager to point to the new location on the engine. This allows the display of
trap information in the Traps Event View tab.

1 From the Console menu bar, select Tools > Alarm/Event > Event View Manager.
2 Click on the Traps entry under Available Log Managers, and click the Edit button.
The Log Manager Parameters window opens.
3 Change the path in the Log Directory field to % ogdi r % t r aps.
Click OK.

Changing Inventory Manager

If you are using Inventory Manager, you must change the Data Storage Directory path to point to the
new location on the engine. The Data Storage Directory is where all Inventory Manager data is stored,
including capacity planning reports, configuration templates, archived configurations, and property files.

1 Open Management Center and select Administration > Options > Inventory Manager.
Select Directory Path in the Data Storage section of the tab.
Change the path to the correct new location.

On a default Linux install, the path is:
/usr/ | ocal / Ext rene_Net wor ks/ Net Si ght / appdat a/ | nvent or yMyr/

4 Click OK.

Changing Engine Settings

Use these steps if you need to change your Extreme Management Center engine settings following your
initial engine configuration.

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP address, enter the
following command at the engine CLI:

/usr/postinstall/dnetconfig

This starts the network configuration script and allows you to make the required changes. Reboot the
engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as system contact, system location, Trap Server, SNMP
Trap Community String, SNMP User, SNMP Authentication, and SNMP Privacy credentials, enter the
following command at the engine CLI:

/usr/postinstall/snnpconfig

This starts the SNMP configuration script and allows you to make the required changes.
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Changing Date and Time Settings

To enable or disable NTP for engine date and time, or to manually set the date and time on the engine,
enter the following command at the engine CLI:

/usr/postinstall/dateconfig

This starts the date and time configuration script and allows you to change the settings.

Upgrading Extreme Management Center Engine Software

Upgrades to the Extreme Management Center engine software are available on the NMS web page.

1

On a system with an internet connection, go to the Extreme Management Center Downloads web
page to download the Engine Image 64-bit upgrade file to your system: http://
extranet.extremenetworks.com/downloads/pages/NMS.aspx

Enter your email address and password.

The Extreme Management Center page displays.

Click on the Software tab and select a version of Extreme Management Center. Scroll down to see
the engine images.

Use FTP, SCP, or a shared mount point, to copy the upgrade file to the Extreme Management Center
engine.

SSH to the engine.

Cd to the directory where you downloaded the upgrade file.

Change the permissions on the upgrade file by entering the following command:

chnod 755 Net Si ght _Suite_<version>_install.bin

Run the install program by entering the following command:

./ Net Sight _Suite <version>_install.bin

The upgrade automatically begins.

The Extreme Management Center Server is restarted automatically when the upgrade is complete.
Because your Extreme Management Center engine settings were migrated, you are not required to
perform any configuration on the engine following the upgrade.
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3 Reinstalling Engine Software

Use the procedure in this chapter to reinstall the engine software, in the event a software reinstall
becomes necessary. Be aware this procedure reformats the hard drive and reinstalls all the engine
software, the operating system, and all related Linux packages.

Connect a monitor and a USB keyboard to the engine prior to performing these steps.

1

9

On a Windows platform system, go to the Extreme Management Center web page to download the
Engine Image 64-bit file to your system: http://extranet.extremenetworks.com/downloads/pages/
NMS.aspx

After entering your email address and password, you are on the Extreme Management Center page.
Click on the Software tab and select a version of Extreme Management Center. Scroll down to the
Engine Image 64-bit (ZIP) file and extract the file to a directory on your system.

Insert the USB flash drive that came with the engine into the USB port on your system and note the
drive letter it is assigned.

Open a command prompt window and cd to the directory where you extracted the file.
Type make di sk. bat <drive letter>:.

F Note
é Because the reinstall procedure reformats the drive, be sure you have specified the correct
drive letter.

Press [Enter].

The files are copied to the USB flash drive. When the copy is complete you see the message:
Successfully installed into <drive letter> Press any key to continue.

Remove the USB flash drive from your system.
Insert the USB flash drive into a USB port on the engine (see Figure 1 on page 9).
Boot the engine from the USB drive using either of these two methods.

e Method 1:

Press the power button, and then press F6 to go to the Boot Menu.

Select the USB drive on the menu.

The engine starts booting from the USB flash drive.

When the boot is complete, the Engine Installation screen appears and the installation begins.

AN DN

e Method 2:

Press the power button, and then press F2 to go to the BIOS setup.
Use the arrow keys to navigate to the Boot Options menu.
Ensure that the USB flash drive is listed as Boot Option #1 at the top.
Save changes and exit.
The engine starts booting from the USB flash drive.
6 When the boot is complete, the Engine Installation screen appears and the installation begins.
After the installation completes, reboot the engine and remove the USB flash drive.

g D NN

10 Proceed to Configuration on page 14, and follow the instructions for configuring the engine.
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